
All of us as educators hope that teaching English as a second language (ESL) will bring
our students greater options and opportunities. Learning Computers, Speaking English
gives ESL students practice in English and at the same time provides access to the
computer skills needed to enter today’s technology-based society.

Using a unique approach, Learning Computers, Speaking English will extend literacy in
both English and computers. Each unit in the book combines review of a grammar topic
with computer instruction, which ranges from the study of computer hardware and
keyboarding to the functions of windows and the basic tools needed for word processing.
After students are introduced to a set of computer instructions, they apply this new skill
in language-learning activities that feature the four skill areas. The book and the disk
provide many activities that invite students to work cooperatively, thus adding to the
communicative thrust of the book. Many activities involve a job-readiness component, so
that when students complete the book, they will have created a portfolio of projects,
which include an office memo, a cover letter, and a resume.
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We believe that the ten minutes it takes to read the Notes to the Teacher section could
avoid confusion and those embarrassing moments that can sometimes occur when
working with technology. We think you will be glad you took the time!
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Students:  The book is geared primarily toward intermediate-level ESL students but is
designed to work across a range of abilities. To engage the more advanced students, aside
from the new computer terminology, we have included some challenging vocabulary and
idioms within readings and grammar boxes. This book can also be used with high-
beginners if the teacher prepares students for the vocabulary, goes over the instructions
slowly, and uses the grammar instruction boxes with complete lessons rather than as
review. It could also be a useful addition to a vocational ESL program where the
computer course would not be taught in isolation from English.

Introduction
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Teachers:   This book provides easy-to-understand instructions for use by teachers who
have experience with computers or by those who do not and may be just a chapter ahead
of the class.
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Throughout the book, most activities are designed for students to work in pairs. Our
approach is based on the belief that learning computers can and should be a
communicative venture. Also, in some language programs, computers are shared, which
is beneficial because it encourages cooperation among students. Teachers are asked to
have students working on their own computers to collaborate with others. Each section
begins by introducing students to the computer terms that will be covered in the chapter,
definitions of which can be found in the book’s glossary. This introduction also
preteaches topics, orienting students to the value and function of a particular aspect of
word processing.

Computing —Step-by-step directions for computer functions are given, usually
accompanied by images of the way the computer screen appears while using that
function. Although some students may be ready to read and experiment on their own,
most will need instruction from the teacher. We suggest that, whenever possible, teachers
use the upcoming activities, called Processing It, for their demonstration of a computer
function. This way, students will be learning the computer function and, at the same time,
becoming familiar with the upcoming activity.

Processing It —These are activities on the disk that students will use to process and
apply what they have learned in the instruction received in the Computing section. Note:
The names of some activities are questions; unfortunately, question marks cannot be used
in file names.

Linking to Language —Language Links appear throughout the book, indicating that a
new grammar topic will be practiced in the activities that follow. Each numbered
Language Link refers to a grammar review box, which can be found at the end of the unit.
For more comprehensive coverage of the grammar topics, you may want to refer to the
Clear Grammar series by Keith S. Folse, also published by the University of Michigan
Press.

Tuning In —This component provides the opportunity for students to engage in a range
of listening activities, from simple dictation to auditory discrimination.

Connecting —In pairs or groups, students practice speaking and listening as part of
conversation or pronunciation activities. Our approach is based on the fact that in some
language programs computers are shared, which is beneficial because it encourages
cooperation among students. Teachers are asked to have students working on their own
computers to pair up with others.
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Printing It Out —Students integrate the computer concepts, grammar, and vocabulary
and then apply it in their writing.

Screening for Meaning —Each section ends with a dialogue between students who
regularly practice in the computer lab. Marina is a student who has taken the course the
previous semester, and Chan and Igor are friends who are presently taking the course.
The characters find themselves discussing provocative topics such as bringing up
children in a new country, different kinds of relationships, discrimination, as well as the
difficulty of balancing work and study. You may want to preview these topics and the
questions that follow in order to prepare for the lively discussions that you will be
facilitating. Students may read this section silently, role play it, or listen to the teacher
read it. Included are a few advanced idioms and expressions. The readings in the first
chapters in each unit are accompanied by comprehension questions called Monitoring
Your Comprehension, and the last chapter in each unit has questions for discussion called
Networking.

Unit Review —The unit review includes Testing Your Knowledge, with a fill-in-the-
blank or cloze activity that reviews the grammar and computer topics, and Applying Your
Knowledge, in which students develop a job-related portfolio project that they add to as
they progress through the book.
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This book can provide the entire curriculum for a class, or the teacher can select
activities, including those on the disk, as a creative way to introduce ESL students to
word-processing basics. Although it is possible to change the order of some units, we
advise you to check for prerequisite skills because units are written assuming competency
in previously covered skill areas.

As with the other ESL textbooks that you use, it is not necessary to include all of the
material in the units in your lessons. For example you may decide to use only the
introductions with the instructions to the computer functions and omit the grammar
lessons. Another alternative is to cover only the computer instructions along with one of
the exercises. If you find it more convenient to do so, you can go over the grammar and
the other English activities outside the computer lab during the regular classroom time or
assign them for homework.

Depending on the computer competency of the students in your class, as well as the
computer time that is available to you, it may not be feasible to use the entire book. The
following provides guidance on which units are the most appropriate for classes
depending on the level of experience with computers:
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� For a class with no experience with computers:
&RPSXWHU#%DVLFV=

Unit 1
Learning Computer Basics and Commands
Unit 2
Learning about the Mouse, Desktop, and the Future Tense
Unit 3
Learning the Keyboard and Gerunds/Infinitives

� For a class that knows mouse basics, how to start up the computer, and how to open
and close documents:
:RUG03URFHVVLQJ#%DVLFV====

Unit 3
Learning the Keyboard and Gerunds/Infinitives
Unit 4
Learning about Windows and the Past Tense
Unit 5
Learning the File Menu and the Present Perfect

� For a class that knows some computer and word-processing basics:
,QWHUPHGLDWH#:RUG#3URFHVVLQJ=

Unit 6
Learning the Edit Menu and Comparatives and Superlatives
Unit 7
Learning the Format Menu and the Passive
Unit 8
Learning the Help Menu and Conditionals

High-beginning level students may benefit from a more extensive study of the grammar
found in the Language Link sections, while intermediate and more advanced students can
briefly refer to them as a review. All students can refer to these sections during the
exercises or later for individualized study.

(GXFDWLRQDO#&RQVLGHUDWLRQV#IRU#WKH#&ODVVURRP

� Make sure students understand that this is not primarily a computer course but a
course integrating both English and computer content. We have found that many
students prefer combining the two so they can improve both skills, but not at the
expense of their study of either.

� When covering the Computing sections, it is a good idea to go over the computer
function instructions while students are working in Microsoft WordPad, the basic
word-processing application that is packaged with Windows 95 and higher versions.
This allows students to have practice before working with the activities that follow.

� One of the challenges for ESL teachers can be having students of varied levels of
English in the same class. The same is true of computer class. In addition, some
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students take to computers more easily than others, especially if they have had some
experience with them or even with a typewriter. The following are some suggestions
to make computer/ESL classes more constructive:

9 Place more experienced students beside those who are less experienced.

9 Make yourself more accessible to those who are less comfortable with
computers.

9 We have made the analogy to students that participating in a computer class is
like walking in the woods: you can go down a path without the group and take
a chance of getting lost, or you can stay with the group and make sure you are
on the right path. Although it may seem overly rigid, keep the group together
when leading them through the computer instructions by periodically
checking that everybody is “on the same page” and understands before
moving on. The risk of letting some students move ahead while others are
catching up is that they may get lost on the computer. Then you may need to
stop the class to help them get reoriented. This makes the rest of the class wait
and can cause students to feel like they are wasting time.

� In the long run it is better to go slowly and have the more computer-adept students
assist the less computer-adept ones. If you have volunteers or teacher aides, this is a
great time and place to ask them for assistance.

� You may prefer to have students focus on the tool bar, as mentioned in the Tips
sections, to access commands, instead of using the drop-down menus. Both ways are
covered in the book so that teachers can choose to have students use the easier way or
to have them learn more in-depth about working with windows.

� It is always important to incorporate time at the beginning of class to review the
previous lesson, but it is especially so with a computer course. Briefly go over
material from the previous class by having students actually run through the computer
competencies and describe what steps they are taking as they do them.
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Teacher instructions are included in the text of the book. Here we offer tips for preparing
successful lessons. Be sure to try out the disk activities before doing them with your class
so you are familiar with what should happen.
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Because of the added factor of using technology, we recommend allowing more time than
you might plan for in a typical ESL lesson. For example, teachers need to factor in how
the technology might behave for you on any given day. You also have to be prepared for
the amount of time it may take for some students to complete projects that involve a lot
of typing.

&RPSXWHU#&RQVLGHUDWLRQV

� Our lessons are based on Microsoft WordPad, which comes in Windows 95 or higher.
A teacher working on other PC or Macintosh applications could use this book as a
resource and adapt the lessons. In order to work with these applications, teachers
would need to rework the Computing sections and adjust the activities on the disk.

� When closing a document, you can tell students not to save changes to the document
so they can practice again in WordPad. Or, you may want to tell them to save the
changes if you want them to have a record of their work or if you want to check their
work later.

� On the disk, within each unit folder, we provide both a Teacher Folder and a Student
Folder. The Teacher Folder can be used if you wish to leave an assignment or
comment for the student. The Student Folder is the place that a student’s portfolio
work can be saved.

� Keep the disks in the classroom so you can review their work and make notes for
them. This also minimizes the likelihood of viruses making their way from other
computers onto yours.

� We recommend having a computer-screen projection device to show the class the
computer function that you are teaching. The devices used to connect to a television
and overhead projector can be relatively inexpensive.

� A lesson we have learned the hard way is not to assume that all computers will be
working the same way that we left them. For example, if you ask students to look in a
particular spot on the computer screen for the Start button and previous users have
changed its location on some of the desktops, this could lead to confusion. When you
have a limited time schedule for the class, this could be frustrating because you then
need to take time out of the lesson to reset the computers. This kind of problem can
sometimes disconcert teachers so much so that they are hesitant about using the
technology again. If you don’t like surprises, check out the equipment first to see if
all the computers are working and if they are set up the way you prefer. It never hurts
to have a back-up plan when working with technology in case the worst happens and
the computers go down.
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� If what you see is not exactly what the book describes:

1. Check to see you are in WordPad and not Word, Works, or Notepad. This can
happen if students mistakenly choose the wrong application to open, or if a
document is opened by double clicking on its icon, rather than opening it
through WordPad. Opening up in another application may occur if you have a
more advanced word-processing application than WordPad, such as Word 97.
Simply close the incorrect application without saving changes, (Do not save
the document in the higher version because formatting can be lost when
switching between applications.) open WordPad, and open the document.

Note: A few of the disk activities have been created in Notepad intentionally.

2. Check to make sure you are using the default settings. For a few of the
activities, we give instructions in the Teacher Notes about some adjustments
to a setting.

3. You may be using a different setting or another version of Windows. Some
things such as dialogue boxes may look slightly different, but are similar
enough to figure out. For example, your settings may cause a file name to
have .doc at the end. This is simply identifying the file as a document and not,
for example, a sound file.

� If the monitor or the central-processing unit (CPU) is not on, the students could have
pressed the power button too lightly. Make sure they press it with a little force. Of
course, you can always make sure that it is still plugged in.

� If students have a document open but say that they can’t see any words, they may
have scrolled down too far in the document or hit the wrong key. Ask them to scroll
up in the document.

� If students can’t find a document they had saved, they may have mistakenly saved
their documents some other place such as the desktop or somewhere in the C drive.
Check these places or use the Find function on the Start menu.

� Always a lifesaver—use the Undo button to undo most word-processing mistakes.




